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After completing this section, students
will be able to:-

Adobe
Photoshop

• define adobe photoshop
• describe applications of photoshop
• explain basic tools of adobe photoshop (selection
tools, burn tool, history, pen tools, smudge tool, crop
tool, blur, dodge and sponge etc.).
• describe popular file formats in photoshop (jpeg, gif
& png etc.)

Adobe Photoshop

Adobe Photoshop is the software that is extensively used
for raster image editing, graphic design and digital art.
Adobe Photoshop, computer application software



used to edit and manipulate digital images. Photoshop
was developed in 1987 by the American brothers Thomas
and John Knoll, who sold the distribution license to Adobe
Systems Incorporated in 1988. 

Raster Image:
In computer graphics and digital photography, a raster
graphic is a dot matrix data structure that represents a
generally rectangular grid of pixels.

Vector:
Vector graphics are computer graphics images that are
defined in terms of points on a cartesian plane, which are
connected by lines and curves to form polygons and other
shapes. Example given in below image: 

Applications of Photoshop 
We can use Adobe Photoshop to retouch our scanned or
digital photographs. We can improve the color tone and
brightness of the pictures into a fresh style.



Basic tools in Photoshop

We can also remove the unwanted dots using blur tool,
photo filter, and color lookup. In Adobe Photoshop, we
can remove or change the backgrounds of our
photographs. Changing the color of clothes, hair, and
eyes is very simple when you use this software. We can
add a person to the photograph and make it look like an
original one. Adobe Photoshop helps us to retouch,
sharpen and enhance the photos in high quality

The Rectangular marquee and Elliptical marquee tools are
hidden in the Toolbox under one and the same icon as
can be seen in Figure 3.2. The icon on the Toolbox
displays the last tool used. To open the floating menu,
right click on the arrow in the lower right corner of the
displayed icon.

Selection Tools: 
Adobe Photoshop also offers a number of selection tools:
Quick Mask, Rectangular marquee, Elliptical marquee,
Lasso, Polygonal Lasso, Magnetic Lasso, Magic Wand. 

Quick Mask mode:
To switch from Standard mode to Quick Mask mode, press
the Q button. Paint over the areas to be selected with a
hard-edge Brush (in Quick Mask mode the selected area
is highlighted in semitransparent red), then switch back to
Standard mode by pressing the Q button again.

Rectangular Marquee:



This tool selects rectangular and square areas. To select a
rectangular area, you should:

To select a square area of the image, make a selection
keeping the Shift key pressed. Take into account that if
you already have a selected area the new selection will
be added to the previous one. To avoid it you should
press the Shift key only when you start selecting a new
area. 

Step 1. Activate the Rectangular marquee tool by clicking
on the icon The Rectangular marquee tool, or (if the
rectangular marquee was not the last tool applied) select
it from the floating window.

Step 2. Bring the mouse cursor to the point of the image
where the corner of an imaginary rectangle should be,
and press the left mouse button.

Step 3. Keeping the left button pressed, move the cursor
diagonally to the opposite corner and release the button.



Elliptical marquee:
This tool selects ellipses and circles. To select an elliptical
area, you should: 

Step 1. Select the Elliptical marquee tool from the Toolbox
by clicking on the icon The Elliptical marquee tool, or (if
the Elliptical marquee was not the last tool applied)
select it from the floating window.

Step 2. Bring the mouse cursor to the point of the image
where the corner of an imaginary rectangle with an
inscribed ellipse should be, and press the left button.

Step 3. Keeping the left button pressed, move the cursor
diagonally to the opposite corner and release the button.
To select a circular area of the image, make a selection
keeping the Shift key pressed. Take into account that if
you already have a selected area the new selection will
be added to the previous one. To avoid it you should press
the Shift key only when you start selecting a new area. If
you keep the Alt (Option in Mac) key pressed when
selecting an elliptical or a rectangular area the selection
is generated from the center to borders, not from one
corner to another.

The Lasso, Polygonal Lasso, Magnetic Lasso tools are
hidden in the Toolbox under one and the same icon as can
be seen in Figure 3.3. The icon on the Toolbox displays the
last tool selected. To open the floating menu right-click on
the arrow in the lower right corner of the displayed icon. 



The tool allows creating freehand selections. To make a
freehand selection you should:

Step 1. Select the Lasso tool from the Toolbox by left-
clicking on the icon Lasso tool, or (if Lasso was not the last
tool applied) select it from the floating window. 
Step 2. Bring the mouse cursor to the object that must be
selected and outline it keeping the left button pressed.

The tool makes freehand selections, but its contour is made
up of straight segments.
To make a selection you should: 
Step 1. Select the Polygonal Lasso tool from the Toolbox by
clicking on the icon The Polygonal Lasso tool, or (if Polygonal
Lasso was not the last tool applied) select it from the floating
window

Lasso

Polygonal Lasso



Step 2. Bring the cursor to any point near the object to
be outlined and press the left mouse button - it'll be the
first point of the contour.

This tool makes a freehand selection.

Step 3. Move the cursor to the next point of the contour
not far from the first one and left-click it again. The
program will automatically draw a straight line between
the two points.

Step 4. Keep putting points in this way until the whole
object is outlined and close the contour

When you use Magnetic Lasso, you do not need to follow the
contour of the object precisely. If the object stands out
against the background the border of the selected area will
be traced automatically as you move the cursor along the
object. To select an area using Magnetic lasso you should:

Step 1. Select the Magnetic Lasso tool from the Toolbox by
clicking on the icon The Magnetic Lasso tool, or (if Magnetic
Lasso was not the last tool applied) select it from the
floating window.
Step 2. Bring the mouse cursor to the border of the object
that you need to be selected.

Step 3. Press the left button and start dragging the
cursor along the object. Pay attention to fastening points
that appear as you outline the object and when you
make a click.                                                                               

Magnetic Lasso



If a fastening point is irrelevant, you can remove it by
pressing the Delete key and return to the previous
fastening point to continue outlining the object.
Step 4. Close the contour, that is join the first fastening
point with the last one by bringing the cursor to the first
point or by making a double-click.

This tool selects a consistently colored area. You can set
Tolerance in the Options palette of the Magic Wand tool.
The higher is the value, the more colors will fall into the
selected area. The Tolerance value ranges from 0 to 255. At
Tolerance equal to 0 the selected area will be represented
only by one color, at Tolerance equal to 255 - all colors of
the image will be selected, that is the whole image. 

To select a consistently colored area, you should: 

Step 1. Select the Magic Wand tool in the Toolbox by
clicking the icon The Magic Wand tool.

Step 2. Bring the cursor to the pixel of the image that must
be included into the selection and leftclick it. As a result, an
outline appears around the pixel. It includes colors of the
image similar to the color of the selected pixel according to
the specified Tolerance value.

These selection tools are efficient due to the flexibility
of their usage: you can add to, subtract from or
intersect a selection.

Magic Wand



Burn Tool

To add an area to the previous selection you should
press the Shift key before you use a selection tool and,
keeping it pressed, make a new selection
To subtract an area from the previous selection you
should press the Alt (Option in Mac) key before you use
a selection tool and, keeping it pressed, make a new
selection
If you press Shift and Alt (Shift and Option in Mac) keys
simultaneously you obtain an intersection of the old and
new selections

Burn tool is present in the toolbox as shown below; the
shortcut is “o” to use the tool.



Using Burn Tool:

With the Burn tool, you can darken the pixels in the
location of the brush stroke. This makes the background
color darker on the area of the brush stroke.

In Photoshop Components, you could lighten or darken
area of a picture utilizing the Dodge as well as Burn tools,
respectively. You can specify the size as well as softness
of your tool by just choosing from among the several brush
pointers. You can also restrict the adjustment to various
tonal ranges in your photo-- shadows, midtones, or
highlights. You likewise could adjust the amount of
modification that's applied by defining a direct exposure
percentage.



Choose either the Dodge (to lighten) or Burn (to darken)
tool from the Tools panel in Edit Full mode. Press Shift+O
to cycle via the Dodge, Burn, and also Sponge tools.

1- Select a brush from the Brush Preset Picker drop-down
panel and also change the brush size, if necessary. Larger,
softer brushes spread the dodging or burning effect over
a bigger area, making mixing with the bordering area less
complicated.

2- From the Range pop-up checklist, select Shadows,
Midtones, or Highlights. Select Shadows to darken or
lighten the darker areas of your image. Select Midtones to
adjust the tones of average darkness. Select highlights to
make the light area lighter or darker.

3- Choose the quantity of improvement you wish to apply
with each stroke by readjusting the Exposure setup. 



History

The History Panel is a tool which creates a chronological
top-down view of everything you do in your working
session in Photoshop. To access the History Panel,
choose Window > History, or click the History Panel tab if
it’s already activated in your workspace (highlighted in
the Featured image).

Beginning with a reduced percentage to far better
control the quantity of darkening or lightening. Direct
exposure is similar to the opacity setting that you utilize
with the Brush tool.

4- Paint over the locations you want to lighten or dim. If
you don't like the results, press Ctrl+Z (cmd+Z on the
Mac) to reverse.



Every move you make, from brush strokes to selections,
is recorded and referred to as a History State or State
for short, and each State appears in the panel. We can
use this list of History States to, as I like to say, ‘time
travel’ without the need for a flux capacitor.

As we angrily spam our Ctrl + Z (Windows) or + Z (Mac)
after we’ve made a dreadful mistake, we’re actually going
back state by state to a time when we were happy with
our work, and from that previous State we can start
anew.Amore thoughtful, timid and alternate approach
would be by clicking on a specific State within the History
Panel list itself and continuing on from there. Let’s face it,
though, we all like to spam our “ctrl + Z” shortcuts, and it’s
not a bad thing, an example of History ,Where Brush tool is
used multiple times on an image.



Pen Tool
Photoshop provides multiple Pen tools to suit your use cases
and creative style:

The Curvature Pen tool lets you intuitively draw curves
and straight segments.
The Standard Pen tool lets you draw straight segments
and curves with great precision.
The Freeform Pen tool lets you draw paths as if you were
drawing with pencil on a piece of paper
The Magnetic Pen options let you draw a path that
snaps to the edges of the defined areas in your image.
The Content-Aware Tracing tool lets you automate the
process for tracing images 

Use the Shift+P key combination to cycle through the tools in
the Pen group



Draw straight line segments

The simplest path you can draw with the standard Pen tool is
a straight line, made by clicking the Pen tool to create two
anchor points.By continuing to click, you create a pathmade
ofstraight-linesegments connected by corner points

Select the Pen tool.

Position the Pen tool where you want the straight
segment to begin, and click to define the first anchor
point (do not drag).
Click again where you want the segment to end (Shift-
click to constrain the angle of the segment to a multiple
of 45°).
Continue clicking to set anchor points for additional
straight segments.

The last anchor point you add always appears as a solid
square, indicating that it is selected.

Previously defined anchor points become hollow, and
deselected, as you add more anchor points.



Content-Aware Tracing Tool

The Content-Aware Tracing Tool is being introduced as a
Technology Preview in the October 2020 release of
Photoshop and lets you create vector paths and selections
by simply hovering over the edges of your image and
clicking. You can enable the Content-Aware Tracing Tool in
Preferences > Technology Previews and then restart
Photoshop.

Complete the path by doing one of the following: 

1- To close the path, position the Pen tool over the first

(hollow) anchor point. A small circle appears next to the Pen

tool pointer when it is positioned correctly. Click or drag to

close the path. 

2- To leave the path open, Ctrl-click (Windows) or

Command-click (Mac OS) anywhere away from allobjects. 

3- To leave the path open, you can also select a different

tool. 

Try out the Content-Aware Tracing Tool by following the
below five simple steps: 1- From the Pen tools group, select
the Content-Aware Tracing Tool.



4- To add to the path, hover over an adjacent edge to
highlight a new section and hold the Shift key while clicking
to extended the path. The pink line that appears indicates
that you're adding a new section to the existing path.

2- Hover the cursor over the edge of an object to

highlight it

3- Click on the highlighted section to create a path 



Details

5- To delete an area from the path, hold down the Alt

key (Windows) or Option key (Mac) while you click. You

can also click and drag in a direction to remove larger

sections. 

While adjusting the Detail slider, Photoshop displays a
preview of the edges that Photoshop sees. Moving the slider
to the right increases the amount of edges Photoshop
detects and moving to the left decreases the number of
detected edges.



Tracing

Smudge

Tracing modes (Detailed, Normal, and Simplified) adjust how
detailed or textured the image dis prior to processing the
tracing 

The Smudge tool simulates the effect you see when you
drag a finger through wet paint. The tool picks up color
where the stroke begins and pushes it in the direction you
drag. 
1- Select the Smudge tool. 
2- Choose a brush tip and options for the blending mode in the
options bar. 
3- Select Sample All Layers in the options bar to smudge using
color data from all visible layers. If this is deselected, the Smudge
tool uses colors from only the active layer. 
4- Select Finger Painting in the options bar to smudge using the
foreground color at the beginning of each stroke. If this is
deselected, the Smudge tool uses the color under the pointer at
the beginning of each stroke. 
5- Drag in the image to smudge the pixels.



Crop a Photo 
1- From the toolbar, select the Crop Tool. Crop borders display on

the edges of the photo. 

2- Draw a new cropping area or drag the corner and edge

handles to specify the crop boundaries in your photo. 

3- (Optional) Specify the Crop options using the Control bar. 

Crop Tool
Cropping is the process of removing portions of a photo to
create focus or strengthen the composition. Use the Crop
tool to crop and straighten photos in Photoshop. The Crop
tool is nondestructive, and you can choose to retain the
cropped pixels to optimize the crop boundaries later. The
Crop tool also provides intuitive methods to straighten a
photo while cropping.

For all operations, visual guides provide an interactive
preview. When you crop or straighten photos, real-time
feedback helps you visualize the final result. 

A. Aspect Ratio Menu B. Swap Width and Height values C.
Overlay Options

Choose a ratio or size for the crop box. You can also choose
a preset, enter your own, or even define your own preset
values for later use.



Auto Center Preview
Enable this option to place the preview in the center of the

canvas.

Overlay Options
Choose a view to display overlay guides while cropping.
Guides such as Rule of Thirds, Grid, and Golden Ratio are
available. To cycle through all the options, press O.

Click the Settings (gear) menu to specify additional crop
options

Crop Options 

Use Classic mode
Enable this option if you want to use the Crop tool in
Photoshop CS5.

Show Cropped Area
Enable this option to display the area that is cropped. If this

option is disabled, only the final area is previewed. 

Enable Crop Shield
Use the crop shield to overlay the cropped areas with a tint.

You can specify a color and opacity. If you Enable Auto

Adjust Opacity, the opacity is reduced when you edit the

crop boundaries. 
Delete cropped pixels
Disable this option to apply a non-destructive crop and

retain pixels outside the crop boundaries. Nondestructive

cropping does not remove any pixels. 



Blur Tool

1- In Photoshop, go to Filter > Blur Gallery as can be seen in figure

3.15 and select Iris Blur. 

2- Click the pin at the center of the ring and place it on your

focal point. 

3- Click and drag single points to elongate the ellipsis or drag the

outer line to resize the blur area. 

4- Click and drag the dots inside the blur preview ring to adjust

the size of the blur transition area. 

5- Adjust the round blur dial to control the amount of blur

applied.

6- When you’re finished, press Enter or click OK at the top of the

Blur Gallery window. 

You can later click the image to see areas outside current
crop borders. Enable this option to delete any pixels that are
outside the crop area. These pixels are lost and are not
available for future adjustments.



Dodge and Sponge tool

Popular File Formats in
Photoshop

There are three Ranges: Shadows, Midtones, and Highlights. Each

choice will only affect the area falling into your category choice.

The Exposure slider, with values ranging from 1% to 100%, sets the

intensity of the effect. The default is 50%. What this means is that,

if Midtones are set to 50%, then only the midtones will be

darkened or lightened to a maximum of 50%.

Dodge Tool

Sponge Tool
There are two mode choices: Desaturate and Saturate.

Desaturate reduces the color intensity and Saturate increasesthe

color intensity of the area being painted. Flow is a bit

different.The value ranges from 1% to 100% and refers to how

quickly the effect is applied. 

Many file formats use compression to reduce the file size of

bitmap images. Lossless techniques compress the file without

removing image detail or color information; lossy techniques

remove detail. The following are commonly used compression

techniques: 

RLE (Run Length Encoding) Lossless compression; supported by

some common Windows file formats.

LZW (Lemple-Zif-Welch)

LZW (Lemple-Zif-Welch)

Lossless compression; supported by TIFF, PDF, GIF, and PostScript
language file formats. 



Lossy compression; supported by JPEG, TIFF, PDF, and PostScript

language file formats. Recommended for continuous-tone

images,such as photographs.JPEG useslossy compression. To

specify image quality, choose

JPEG (Joint Photographic
Experts Group)

Afamily of lossless compression techniquesfor black-and-white

images,supported by the PDF and PostScript language file

formats. (CCITT is an abbreviation for the French spelling of

International Telegraph and Telekeyed Consultive Committee.)

After completing this section, students will be able to: - 

Quality text box. For the best printed results, choose maximum-

quality compression.JPEG files can be printed only on Level 2 (or

later) PostScript printers and may not separate into individual

plates.

CCITT

ZIP
Lossless compression; supported by PDF and TIFF file formats. Like

LZW, ZIP compression is most effective for images that contain

large areas of single color.

define home screen 

understand workspace 

understand about user interface of photoshop 

describe properties of different tool 

describe about panels and panel location 

define how to import and export files 

understand concept of save files for web and print



The Search bar at the top of the Home Screen in Photoshop

Elements lets you search and find help files and tutorials. To

search, enter the desired text in the Search bar and then press

your keyboard’s “Enter” key. Matching results appear via

thumbnails and hyperlinks in the Home Screen. To access the help

documentation, click a thumbnail or hyperlink to open the page in

your web browser. To return “Home” in the Home Screen, click the

“Home” link in the breadcrumbs area in the upperleft corner of the

screen. 

The Home Screen in Photoshop Elements appears after opening

Photoshop Elements 2019 or later. This screen replaces the

Welcome Screen in Photoshop Elements from older software

versions. The Home Screen in Photoshop Elements contains auto-

generated photo and video collages and slideshows from

imported media. It also lets you find new editing projects, get

inspiring ideas, open different workspaces, open recent files, and

get help.

Home Screen



Workspaces give us a way to customize Photoshop’s interface for

specific tasks, and to better match the way we work. Photoshop

includes far too many panels to fit them all on your screen at

once, so it's important that we limit the panels to just the ones we

actually need. A photographer, for example, will use certain

panels for image editing and retouching. A digital painter, on the

other hand, will need different panels, ones for choosing brushes

and colors. Other tasks, like web and graphic design, video

editing, or working with type and typography, all use specific

panels. A workspace streamlines the interface for the task at

hand, keeping your screen free of clutter and helping you work

more efficiently. 

Aworkspace is a preset layoutforthe various elementsthatmake up

Photoshop'sinterface.Workspaces determine which of Photoshop's

panels are displayed on your screen and how those panels are

arranged.Aworkspace can also change which tools are available

in the Toolbar and how the Toolbar is organized. Workspaces may

include custom menu items in the Menu Bar, and even custom

keyboard shortcuts.Any or all of these elements can be included

and saved as part of a workspace.

Workspace

Photoshop's default workspace
By default, Photoshop uses a workspace known as Essentials as

can be seen in Figure 3.16. If you've never chosen a different

workspace, you're using the Essentials workspace. It's also the

workspace we use in our tutorials. 



Essentials is a general-purpose workspace, suitable for many

different tasks. It includes some of Photoshop's more commonly-

used panels, like Layers, Adjustments and Properties, along with

the Color and Swatches panels (flowers photo from Adobe

Stock):

The default panels
Let's take a closer look at the default panels. As we learned in the

Managing Panels tutorial, Photoshop's panels are located in

columns along the right of the screen. The libraries panel, new in

Photoshop CC, gets its own column on the far right. Panels we

use the most (Layers, Properties, Color, etc.) are found in the main

column in the middle. And on the left is a narrow column that

holds the History and Device Preview panels. By default, panels in

the left column are collapsed into icons (what Adobe calls iconic

view). You can expand a panel that's in iconic view by clicking its

icon.



Properties of Different tools

Zoomsin or zooms out your image. The related toolsshown in the
Tool Options bar are Zoom In and Zoom Out. For more information
about the Zoom tool, see Zoom in or out. 

Tools in the View group of the Expert mode toolbox

Zoom tool (Z) Zoomsin or zooms

Hand tool (H) 
Moves your photo in the Photoshop Elements workspace. You can
drag your image using this tool.

Tools in the Select group of the Expert
mode toolbox
Move tool (V)
Moves selections or layers. 



Selects an area in your image in a rectangular box. Hold the
Shift key to make the selection a square.

Rectangular Marquee tool (M)

Selects an area in your image in an elliptical shape. Hold the
Shift key to make the selection a circle.

Elliptical Marquee tool (M)

Selects an area in your image in a free-form shape.
Lasso tool (L)

Selects part of an image by selecting the high-contrast edges
around a shape.

Magnetic Lasso tool (L)

Draws straight-edged segments of a selection border. 
Polygonal Lasso tool (L)

Makes a selection based on color and texture similarity when
you click or click-drag the area you want to select.

Quick Selection tool (A)

Selects the area where you paint with the brush.
Selection Brush tool (A)

Selects the pixels with similar colors in a single click.
Magic Wand tool (A)

Adds or removes areas to and from a selection by
automatically detecting the edges. For more information on
this tool, see Edit and refine selections. 

Refine Selection Brush tool (A)

Automatically makes a selection when you draw a shape
around the object you want to select.

Auto Selection tool (A)



Creates soft or hard strokes of color. You can use it to
simulate airbrush techniques.

Brush tool (B) 

Changes the existing colors and details in your image so your
photo looks like it was painted using stylized brush strokes.

Impressionist Brush tool (B)

Simplifies replacing specific colors in your image. 
Color Replacement tool (B)

Erases the pixels in the image as you drag through them
Eraser tool (E) 

Turns color pixels to transparent pixels so that you can easily
remove an object from its background.

Background Eraser tool (E)

Changes all similar pixels when you drag within a photo. For
more information, see Use the Magic Eraser tool. 

Magic Eraser tool (E)

Fills an area that is similar in color value to the pixels you
click.

Paint Bucket tool (K)

Applies a fill or a pattern to your image, instead of using one
of the brush tools.

Pattern tool (K)

Tools in the Draw group of the Expert
mode toolbox

Fills in an area of image by a gradient. For more information,
see Apply a gradient. 

Gradient tool (G) 



Copies or samples the color of an area in your photo to set a
new foreground or background color.

Color Picker tool (I)

Provides different shape options for you to draw. When you
select the Custom Shape tool, you can access these shapes
in the Tool Options bar.

Custom Shape tool (U) 

The other shape-related tools available in the Tool Options
bar are:
Rectangle 
Rounded Rectangle Ellipse 
Polygon Star Line 
Selection

Creates and edits text on your image.
Type tool (T)

Vertical Type Horizontal Type Mask Vertical Type Mask Text on
Selection Text on Shape Text on Custom Path 

Creates hard-edged freehand lines.
Pencil tool (N)

Panels and Panel Location
Panels are available in both Photoshop Elements and Elements
Organizer; however, they behave a little differently in each.
Panels help you manage, monitor, and modify images. Some
panels have menus that provide additional commands and
options. You can organize panels in the basic and custom
workspaces in Expert mode. You can store panels in the Panel Bin
to keep them out of your way



Some commands appear in both the panel menu and the
menu bar. Other commands are exclusive to panel menus.
Click panel menu to view the different commands in each
panel.

Panel menus

Panels contain features, information, or functionality, in
logical groups, for fast and easy access. The Panel Bin is on
the right side of Photoshop Elements. It displays tabs and
panels, depending on the mode you are in, or the kind of
elements you want to work with. The Panel Bin displays:

Work with panels 

Quick mode: lists the quick-mode effects that can be applied
to a photo Guided mode: lists all the guided-mode edits that
you can apply to a photo.
Expert mode: lists the options for a selected panel (Layers,
Effects, Graphics, or Favorites)



In the Expert mode, panels can be displayed in two ways -
Basic Workspace, and Custom Workspace.

Panels in the Expert mode

By default, the available workspace displayed is the Basic
Workspace. In this view, buttons for the most frequently used
panels are placed in the taskbar. The buttons in this
workspace are Layers, Effects, Graphics, and Favorites. For
example, clicking the Layers button displays all the layers-
related options. To view all the other available tabs, or close
open tabs, click More.

Basic Workspace

To view panels in a tabbed layout in the Panel Bin, click the
arrow next to More, and select Custom Workspace. Click
More to view a list of all the available tabs, and select one
from the pop-up list. The selected tab is displayed. You can
keep the frequently used panels open in the custom
workspace. Group panels together or dock one panel at the
bottom of another panel. You can drag title bar of the tab
and drop it in the tabbed layout, or drag-and-drop the tabs
dialog into the tabbed layout

Custom Workspace



In Photoshop, you can choose to open an image to work with
or import content into a document that’s open document, and
you can then use tools to manipulate the imported content, as
shown in the figure.

Import content to Photoshop

Export content from Photoshop
Because Photoshop can export paths in a document to

Illustrator (in an AI file), your work in Photoshop is easy to

manipulate after you open it with Illustrator. 

You have another option, though: Export your Photoshop file

by using the Zoomify feature. This useful feature can export a

large file to a smaller, more compact SWF file. This file can be

easily sent by e-mail and opened using the free Flash Player,

which almost everyone already hasinstalled. 

To use Zoomify, follow these steps:

Click Folder in the Output Location section of the Zoomify

dialog box and choose a folder location for your SWF file.

Choose the quality and size and then click OK. 

The Zoomify Preview window appears. Use this window to

zoom in to see detail. 

You can then retrieve the files that were created in your

destination folder and post them online or attach them to an

e-mail message



One of the more critical functions that Photoshop offers is the
Save for Web/ Devices feature. 

Why use it? While you could just save your file in a standard
method, such File / Save As, the Save for Web/Devices
feature does crucial three things. 

It optimizes the file dimensions (for example: 150 px X 150 px)
allowing it to fit into web pages cleaner and look better and
less distorted. It optimizes the file size (for example: 23 kb)
allowing it to download faster. It saves in the RGB (or monitor)
format as opposed to the CMYK (print) format. This tool works
great for outputting Twitter icons, Facebook profile pics,
product files, blog images and source files for favicons.

Save files for Web and Print

To get started, you’ll need to go to File/Open to open your
file. It can be in any format jpg, gif, psd, png or others. As
long as Photoshop can open it, you can output it for the web
as shown



Go to File / Save for Web/Devices and click. It is about
halfway down the drop-down menu. This process doesn’t
change your original file at all. You are creating a new file.
Once you complete this tutorial and return to your original
image in Photoshop, you’ll need to save that file if you’ve made
any changes to it. It’s important to name your new image
different than your original one. Often simply adding web to
the file name will work well. 

Each of the three jpg options (High, Medium, Low) , have
preset quality settings – which can be manually adjusted. If you
are viewing at 100% you can decide what quality you need. To
adjust the level of zoom, see Step 5. The image will look the
same online as it does in the preview window. If you chose
anything other than jpg you can skip this step. 



Once you have made the necessary adjustments you are ready
to save the file. Click “Save” as can be seen, and choose the
folder and file name you want for this new image.

After completing this section, students will be able to: -
define presets 
describe brushes 
define type faces and font 
learn installation of new brushes and fonts 
learn about usage of presets, brushes, and fonts

Presets
Presets are a collection of edits that are recorded as a batch
and can be applied to an image (or multiple images) with just
one click.

The Preset Manager lets you save or load your presetsfor
contours and tools. Each set of presets has its own file extension
and default folder. Optional preset files are available inside the
Presets folder in the Photoshop application folder.



To open the Preset Manager, choose Edit > Presets > Preset
Manager. Choose a specific Preset Type from the Preset Type
menu.

To delete a preset in the Preset Manager, select the preset and
click Delete. Use the Reset command to restore the default
presets. 

You can adjust the way presets are displayed by clicking the
Preset Manager's gear icon and choosing from the display
modes listed: 

Text Only
Displays the name of each preset item.

Small Thumbnail or Large Thumbnail
Displays a thumbnail of each preset item.

Small List or Large List
Displays the name and thumbnail of each preset item.



Brushes
To open the Preset Manager, choose Edit > Presets > Preset
Manager. Choose a specific Preset Type from the Preset Type
menu. To delete a preset in the Preset Manager, select the
preset and click Delete. Use the Reset command to restore the
default presets. You can adjust the way presets are displayed
by clicking the Preset Manager's gear icon and choosing from
the display modes listed:

Brush Settings panel overview
The Brush Settings panel lets you modify existing brushes and
design new custom brushes. The Brush Settings panel contains
the brush tip options that determine how paint is applied to an
image. The brush stroke preview at the bottom of the panel
shows how paint strokes look with the current brush options 



A. Locked/Unlocked B. Selected brush tip C. Brush stroke
preview D. Brushes panel Installing brushes and brush packs

1- In the Brushes panel, from the flyout menu, choose Get More
Brushes. Alternatively, rightclick a brush listed in the Brushes
panel and select Get More Brushes from the contextual menu.
2- Download a brush pack. For example, download Kyle's
"Megapack". 
3- With Photoshop running, double-click the downloaded ABRfile

You can import a wide variety of free and purchased brushes—
for example, Kyle's Photoshop brush packs into Photoshop.  
Follow these steps:

The brushes you added are now displayed in the Brushes panel. 



Fonts and Typefaces

Fonts
A font is a complete set of characters—letters, numbers, and
symbols—that share a common weight, width,

Typeface
Typefaces (often called type families or font families) are
collections of fonts that share an overall appearance, and are
designed to be used together, such as Adobe Garamond.
Typefaces include many characters in addition to the ones you
see on your keyboard. Depending on the font, these characters
can include ligatures, fractions, and lining figures. 



Installing New font
When you open a document that contains fonts that aren't
installed on your computer, Photoshop automatically fetches
and activates those missing fonts as can be seen in figure 3.28
from Adobe Fonts while you're connected to the internet. 

When you open a document containing type layers, you may see
a blue sync icon over some of the type layers in the Layers panel
indicating an automatic activation of missing fonts from Adobe
Fonts. As the download finishes, the sync icon is replaced by the
standard type layer icon. You can now use the activated font in
your document and also in other applications on your computer. 

When you try to edit a type layer with a missing font while the
font activation isin progress, Photoshop displays a dialog that
asks you to replace the missing font with a default font and
continue editing. In the dialog, you can choose any of the
following: 
Replace: Select to replace missing fonts with the default font.
For Roman text, the default font is Myriad Pro Regular.



Cancel: Select to exit text-editing mode and resume
activation of your missing Adobe Fonts. 

Manage missing non-Adobe fonts 
If you have a missing font as can be seen in figure 3.29 in your
document that is not available via Adobe Fonts, Photoshop
displays a yellow missing font icon over the type layer the
Layers panel.

After completing this section, students will be able to: -
understand mixer brush 
know about brush setting 
learn about mixing of colors 
describe color mixing with photograph 
explain painting and mixing colors with brush pr e se ts

Mixer Brush
The Mixer Brush simulates realistic painting techniques such as
mixing colors on the canvas, combining colors on a brush, and
varying paint wetness across a stroke. The Mixer Brush has two
paint wells, a reservoir and a pickup. The reservoir stores the
final color deposited onto the canvas and has more paint
capacity. 



The pickup well receives paint only from the canvas; its
contents are continuously mixed with canvas colors.
1- Select the Mixer Brush tool. (If necessary, click and hold the
standard Brushtool to reveal the Mixer Brush.) 
2- To load paint into the reservoir, Alt-click (Windows) or
Option-click (Mac OS) the canvas. Or, choose a foreground
color. 
3- Choose a brush from the Brush Presets panel. 
4- In the options bar, set tool options. 

Current Brush Load swatch
From the pop-up panel, click Load Brush to fill the brush with
the reservoir color, or Clean Brush to remove paint from the
brush. To perform these tasks after each stroke, select the
automatic Load or Clean options.

Preset pop-up menu
Applies popular combinations of Wet, Load, and Mix settings.

Wet
Controls how much paint the brush picks up from the canvas.
Higher settings produce longer paint streaks

Photoshop Increasing paint wetness Increasing paint wetness
A. 0% B. 100%



Load
Specifies the amount of paint loaded in the reservoir. At low
load rates, paint strokes dry out more quickly as can be seen

A. 1% B. 100%

Sample All Layers
Picks up canvas color from all visible layers. 

Mix
Controls the ratio of canvas paint to reservoir paint. At 100%,
all paint is picked up from the canvas; at 0%, all paint comes
from the reservoir. (The Wet setting, however, continues to
determine how paints mix on the canvas.)

Colors Primary colors
Additive primaries are the three colors of light (red, green,

and blue) that produce all the colors in the visible spectrum

when added together in different combinations. Adding equal

parts of red, blue, and green light produces white. The

complete absence of red, blue, and green light results in

black. Computer monitors are devices that use the additive

primaries to create color



Subtractive primaries are pigments, which create a spectrum of
colors in different combinations. Unlike monitors, printers use
subtractive primaries (cyan, magenta, yellow, and black pigments)
to produce colors through subtractive mixing. The term
“subtractive” is used because the primary colors are pure until you
begin mixing them together, resulting in colors that are less pure
versions of the primaries. For example, orange is created through
the subtractive mixing of magenta and yellow together. Refer to
the image below.



Color Mixer
If you’re new to adjusting color components, it helps to keep a

standard color wheel diagram on hand when you work on color

balance. You can use the color wheel to predict how a change in

one color component affects other colors and also how changes

translate between RGB and CMYK color models as can be seen

After completing this section, students will be able to: - 

Describe camera raw 

Understand advance color correction 

Learn techniques of using camera raw

Camera Raw
Adobe Camera Raw, which lets you import and enhance raw

images, has been a must-have tool for professional

photographers right since it was first released in 2003. 



Histogram and RGB levels: 

A histogram is a representation of the number of pixels at each

luminance value in an image. A histogram that has non-zero

values for each luminance value indicates an image that takes

advantage of the full tonal scale. One that doesn’t use the full

tonal range corresponds to a dull image that lacks contrast. A

histogram with a spike at the left side indicates shadow clipping;

a histogram with a spike on the right side indicates highlight

clipping. Refer to the figure below: 

Applications that support Adobe Camera Raw include

Photoshop, Photoshop Elements, After Effects, and Bridge.

Additionally, Adobe Lightroom is built upon the same powerful

raw image processing technology that powers Adobe

CameraRaw.

Advance Color Correction



One common task for adjusting an image is to spread out the

pixel values more evenly from left to right on the histogram,

instead of having them bunched up at one end or the other. A

histogram is made up of three ribbons of color that represent the

red, green, and blue color channels. White appears when all

three channels overlap. Yellow, magenta, and cyan appear when

two of the RGB channels overlap (yellow equals the red + green

channels, magenta equals the red + blue channels, and cyan

equals the green + blue channels).

The histogram changes automatically as you adjust the settings in

the Camera Raw dialog box. The RGB values of the pixel under

the pointer (in the preview image) appear below the histogram.

Preview highlight and shadow clipping 

Clipping occurs when the color values of a pixel are higher than

the highest value or lower than the lowest value that can be

represented in the image. Overly bright values are clipped to

output white, and overly dark values are clipped to output black.

The result is a loss of image detail. 

You can view Highlight and Shadow clipping indicators in the

upper corners of the histogram. This is to check areas in your

photo that are either too light or dark, as you make edits. 



1- If the upper-left clipping indicator is illuminated (the clipping

indicator is white), it implies thatshadows are clipped in your

photo. Click the illuminated indicator to view the shadows in your

photo. The shadows are displayed as a blue overlay mask

2- If the upper-right clipping indicator isilluminated (the clipping

indicator is white), it implies that highlights are clipped in your

photo. Click the illuminated indicator to view the highlights in

your photo. The highlights are displayed as a red overlay mask.

Refer to the figure below:

Tone a grayscale or B&W image
Use the controls in the Color Grading panel to color a grayscale

image. 



You can add one color throughout the tonal range or create

a split tone result, in which a different color is applied to the

shadows, midtones, and highlights. The extreme shadows

and highlights remain black and white reference 

Adjust color or tone using the Targeted Adjustment tool

You can also apply special treatments, such as a cross-

processed look, to a color image. 1- Select a grayscale or

B&W image.

2- Click Edit in the right panel and open the Color Grading

drop-down. Use the color wheels for Shadows, Midtones,

and Highlights to adjust the colors in your image. 

The Targeted Adjustment tool allows you to make tonal and color

corrections by dragging directly on a photo. Using the Targeted

Adjustment tool, you can drag down on a blue sky to desaturate

it, for example, or drag up on a red jacket to intensify its hue as

can be seen

1- Open the Curve panel under Edit and select the Targeted

Adjustmenttool. 

In the preview image, dragging the tool up or right increases

values; dragging down or left decreases values. Sliders for more

than one color may be affected when you drag with the

Targeted Adjustment tool.



2- To make tone curve adjustments using the Targeted

Adjustment tool, choose Parametric Curve. Then,drag the

tool in the preview image.

The Parametric Curve Targeted Adjustment tool adjusts the

Highlights, Lights, Darks, or Shadows curve region based on

the values in the image where you click.

Work with Camera Raw
Camera Raw and Lightroom share the same image-processing

technology to ensure consistent and compatible results across

applications. For Camera Raw to view image adjustments made

in the Develop module of Light room, metadata changes must

be saved to XMP in Lightroom. 

Adjustments made in Camera Raw are also displayed in the

Adobe Bridge Content and Preview panels.



The images that you open in Camera Raw are displayed in the

filmstrip, positioned below the preview. You can choose to hide

the filmstrip, sort images based on Capture Date, File Name,

Star Rating, and Color Label, and also filter photos using the

Filter icon

1- In Adobe Bridge, choose Edit > Camera Raw Preferences

(Windows) or Bridge > Camera Raw Preferences (Mac OS).

Or, with the Camera Raw dialog box open, click the Open

Preferences Dialog button.

2- Choose Save Image Settings In > Sidecar “.XMP” Files, and

deselect Ignore Sidecar “.XMP” Files. 3- After applying

adjustments to a photo in Camera Raw, save them by clicking

Done or Open Image.

Filmstrip

You can also move the filmstrip to the left panel, which is

especially useful when working with portraits. To do this,

Control-click (macOS)/Right-click (Windows) the filmstrip and

select Filmstrip Orientation > Vertical. Refer to the figure below:



Layers

After completing this section, students will be able to: - 

define layers 

understand layer panel 

know about arrangement of layers 

earn about grouping of layers 

understand layer style 

comprehend updating the layer style 

understand about the adjustment layer 

understand smart objects

Photoshop layers are like sheets of stacked acetate. You can see

through transparent areas of a layer to the layers below. You

move a layer to position the content on the layer, like sliding a

sheet of acetate in a stack. You can also change the opacity of

a layer to make content partially transparent. 

Photoshop Layers panel overview



A. Layers panel menu B. Filter C. Layer Group D. Layer E.

Expand/Collapse Layer effects F. Layer effect G. Layer thumbnail

The Layers panel in Photoshop lists all layers, layer groups, and

layer effects in an image. You can use the Layers panel to show

and hide layers, create new layers, and work with groups of

layers. You can access additional commands and options in the

Layers panel menu.

Display the Photoshop Layers panel 

1- Choose Window > Layers. Choose a command from the

Photoshop Layers panel menu 

2-Click the triangle in the upper-right corner of the panel.

Change the size of Photoshop layer thumbnails 

3- Choose Panel Options from the Layers panel menu, and select

a thumbnailsize. Change thumbnail contents 

4- Choose Panel Options from the Layers panel menu, and select

Entire Document to display the contentsof the entire document.

Select Layer Bounds to restrict the thumbnail to the object’s pixels

on the layer.



A new image has a single layer. The number of additional layers,

layer effects, and layer sets you can add to an image is limited

only by your computer’s memory. You work with layers in the

Layers panel. Layer groups help you organize and manage

layers. You can use groups to arrange your layers in a logical

order and to reduce clutter in the Layers panel.

You can nest groups within other groups.You can also use

groups to apply attributes and masks to multiple layers

simultaneously. Refer to the figure below:

Organizing Photoshop layers

Layer Panel overview

You can add new layer by clicking on the 2nd last icon from
bottom right



Layer Panel add

You can delete a layer by clicking on the last icon at bottom right

Layer Panel delete

You can change the transparency of a layer by opacity option



Layer Panel transparency

Layers for non-destructive editing
Sometimes layers don’t contain any apparent content. For

example, an adjustment layer holds color or tonal adjustments

that affect the layers below it. Rather than edit image pixels

directly, you can edit anadjustment layer and leave the

underlying pixels unchanged. 

A special type of layer, called a Smart Object, contains one or

more layers of content. You can transform (scale, skew, or

reshape) a Smart Object without directly editing image pixels.

Or, you can edit the Smart Object as a separate image even

after placing it in a Photoshop image. Smart Objects can also

contain smart filter effects, which allow you to apply filters non-

destructively to images so that you can later tweak or remove

the filter effect.


